© 2008 Regents of the University of California
All rights reserved. Published 2006.

Restricted Rights
Printed in the United States of America.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, for any purpose without the express written permission of Financial Systems User Support, University of California, Berkeley.
Table of Contents

BAIRS Advanced - Overview ................................................................. 1
Navigating the BAIRS - Advanced Workspace ........................................ 1
Understand Sections/Panes ...................................................................... 1
Select Personal Page as Browser Default .............................................. 8
Understand the Catalog Pane ............................................................... 9
Understand the Section Bar ................................................................. 9
Understand Toolbars ............................................................................ 9
Understand Standard Toolbar ............................................................... 10
Understand the Format Toolbar ......................................................... 12
Understand Contents Panes ................................................................. 13
Understand Toggle Switches ................................................................. 14
Understand Command Lines ............................................................... 15
Hide/Unhide a Command Line ............................................................. 15
Resize and Dock a Command Line ....................................................... 18
Work with Sections ............................................................................. 21
Add a Section ...................................................................................... 21
Duplicate & Rename a Section ........................................................... 22
Hide/Unhide the Section Pane .............................................................. 24
Delete a Section .................................................................................. 26
Work With The Query Section ............................................................ 28
Build the Request Line ......................................................................... 28
Try to Remove a Critical Item from Request Line ............................... 31
Apply a Sort to a Query ......................................................................... 33
Add a Simple Filter to a Query ............................................................ 36
Remove a Simple Filter from a Query .................................................. 39
Work With the Results Section ........................................................... 42
Add/Remove Local Filters ................................................................. 42
Format Numbers .................................................................................. 46
Create Grouping Columns ................................................................. 49
Create Computed Items ....................................................................... 61
Work with the Report Section ............................................................. 69
Understand the Report Outliner & Add/Remove ................................. 70
Understand Headers and Footers ....................................................... 70

Error! Bookmark not defined.
BAIRS Advanced - Overview

Navigating the BAIRS - Advanced Workspace
This material will familiarize you with the Hyperion Intelligence Client components and toolbar functions. If you only run canned reports and perform functions covered in BAIRS - Basic Reporting, this material may not be necessary for you.

Understand Sections/Panes
The Hyperion workspace is made up of three panes, the Sections, Catalog and Contents panes.

The Sections Pane
The Sections pane lists all the views available in a Hyperion document. Main Page, reports, charts, pivots, results and tables are all types of items in the Sections pane. You can display sections, add new ones, duplicate them, rename them, delete them, and hide or unhide the entire Sections pane.

Procedure
In this example, we will learn to navigate between various BAIRS views and learn more about the various sections and panes provided when one is using more advanced BAIRS features.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1.   | You have run this summary report and are interested in doing more extensive work with the data and need to get to the Section/Catalog options.  
This is sometimes called, "Behind the Main Page". |
| 2.   | You wish to get "behind the Main Page".  
Click View. |
| 3.   | The View drop-down menu appears.  
Click the Section/Catalog option. |
Step | Action
--- | ---
4. | The **Sections Pane** (to the left of the screen) displays the sections that are available. The Catalog and Content/Documentation panes also display. The selected section (in this example, the sort by Org, Fund, Proj, Flex, Pgm) determines what displays in the **Catalog** and **Content/Documentation** panes.

5. | You must display a section to work on it. In this example, there are six different views/sections available for this report and are listed in the left **Sections Pane**.

Notice that the selected option is designated as the depressed box in the Sections pane on the left. Because of this selection, the **Contents Pane** displays that same view as the Sections pane: Org, Fund, Proj, Flex, Pgm.

Notice that the **Catalog Pane** displays options associated with this view of the report.
### Step 6

**We want to work with a different option.**

**Click the Query option.**

### Step 7

**The Query format has command lines, (Request, Filters and Sorts) and one or more Metatopics. There is nothing in the Catalog pane.**

For detailed information about the Query function, see "The Query Section".
Step | Action
--- | ---
8. | We would like to view Results. 
Click the **Results** option.

9. | The **Results** section appears. You can tell that you are viewing Results by the fact that the **Results** button is depressed on Sections pane to the left and by the fact that **Results** is displayed on the Section bar to the upper left.

All three panes are displayed: Sections, Catalog and Content/Document.

Notice there are toggle switches in the upper right hand corner of the report, if you would like to expand the Filters and sort. In addition, there are Back and Forward arrows available.

For additional information on Filter and Sort see those specific topics.
10. In the Results option, data appears in a single table and items from the Request line make up column headings. A row appears for each database record.

Data in the Results section is used to create pivots, charts and tables.

For additional information, see "Work with the Results Section".

11. You want to return to the Select Report to View page in order to change the sort order of this report.

Click the Select Report to View option.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.</td>
<td>You are back on the <strong>Select Report to View</strong> page and are able to sort your report with a different sort order and different subtotal. For additional information, see &quot;BAIRS - Basics: Select a Sort Order&quot;.</td>
</tr>
<tr>
<td>13.</td>
<td>You would like to return to the <strong>Main Page</strong> and enter other parameters. Click the <strong>Main Page</strong> option.</td>
</tr>
</tbody>
</table>
### Select Personal Page as Browser Default

**Procedure**

In this example, we select our Personal Page as the browser default.

After this the Berkeley Reporting Portal, will open to our Personal Page.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Click the <strong>File</strong> button.</td>
</tr>
<tr>
<td>2.</td>
<td>The File drop-down menu appears. Click the <strong>Preferences...</strong> option.</td>
</tr>
<tr>
<td>3.</td>
<td>The Preferences dialog box appears. Under &quot;Default Startup Options&quot; notice that at present the default is the Explore page. We want the Personal Page to be the default. Click the <strong>Explore</strong> drop-down button.</td>
</tr>
<tr>
<td>4.</td>
<td>The Content drop-down menu appears. The option we want is, Favorite. Click in the <strong>Favorite</strong> option.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 5.   | If you would like to have Hyperion use Interactive Reporting as your default, you could select it at this time.  
   For more detailed information, see "Select Interactive Reporting Web Client as Default".  
   Click the **OK** button. |
| 6.   | The Berkeley Reporting Portal will now open on your Personal Page.  
   **End of Procedure.** |

**Understand the Catalog Pane**

The Catalog pane appears on the left side below the Sections pane. The Catalog pane displays items (e.g., fields such as org and fund). You click and drag these items to the appropriate section (e.g., outliners, command lines, etc.) and modify or build your report, pivot, or chart. Items in the Catalog change depending on the section selected. For instance, in the Query section, the Catalog displays tables. In the Pivot section, the Catalog displays request items.

The Catalog appears in a directory tree format. Click the plus sign + next to a folder name to expand the directory tree and the minus sign - to collapse the directory tree.

Listed in descending order are the possible items in the Catalog pane: time elements, money elements, chartstring elements and all other elements.

**Understand the Section Bar**

The Section Bar lies above the Section and Contents panes. It indicates the active section, has toggle switches for outliners or command lines, and has back and forward arrows.

**Toggle Switches**

The toggle switch displays hidden outliners or command lines or hides outliners or command lines that you do not want to view. Hiding outliners and command lines increases what is displayed in the Content/Document Section.

**Understand Toolbars**

Hyperion Intelligence Client has three toolbars, the Standard, Formatting, and Section toolbars.
To display or hide a toolbar, select View, Toolbars, and then the toolbar name. A check by the toolbar names indicates that it is displayed.

**Understand Standard Toolbar**

The Standard Toolbar contains commonly used commands. When a section is selected, only those icons that are used in that particular section are available, the other icons are grayed out.

Typical Standard Toolbar functions might include: Save, Print, Show Section/Catalog, Insert New Section, Properties, Filters, Sort Ascending, Sort Descending, Grand Total, Group Labels and Process, Back, Forward, and Help.

**Procedure**

In this example, we will display the Standard Toolbar.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Click the <strong>View</strong> option.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
<tr>
<td>2.</td>
<td>The View drop-down menu appears. Select the <strong>Toolbars</strong> option.</td>
</tr>
</tbody>
</table>

![Toolbar options](https://docs.google.com/document/d/1Q5Mo1hXaJXoZ_6mZ4Z1U8n7jz2zOOGY/edit)

3. The three toolbar options appear.  
   Click the **Standard** option.  
   A black check mark appears to show which Toolbar is active.

![Standard Toolbar](https://docs.google.com/document/d/1Q5Mo1hXaJXoZ_6mZ4Z1U8n7jz2zOOGY/edit)

4. The **Standard Toolbar** appears.  
   From the Standard toolbar you can: Save, Print, Show Section/Catalog, Insert Query, Process Current or go back to the previous view and request help.

5. **End of Procedure.**
Understand the Format Toolbar
The icons on the Format Toolbar work like icons on many other software programs. The icons allow you to change the font type and point size; make the font bigger or smaller; make the text bold, italic or underlined; left, center or right justify text; change the line, fill, or text color; and format numbers as currency or percentages, add commas, or decrease/increase decimal number.

Procedure

In this example, we will select the Format Toolbar.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Click the View option.</td>
</tr>
</tbody>
</table>
Step | Action
--- | ---
2. | The View drop-down menu appears.  
Select the **Toolbars** option.

3. | The Toolbars drop-down menu appears.  
Click the **Formatting** option.

4. | The **Format toolbar** appears.

5. | **End of Procedure.**

---

**Understand Contents Panes**

The Contents pane displays the section you are using. The Contents pane may show a data model, a pivot, a report or a Main Page. It is subdivided into Documents and Outliner sections. The Outliner section is not available for Query or Main Page.

**The Document Section**

The Document section displays the content of a particular section. For example, the Query section has data tables in the Document section. After a query is processed, the Results section shows raw data and the Report Section displays a report in the Document section.

**The Outliner Section**

Outliners are located at the bottom of the Contents pane. They are "drag" and "drop" templates used in Table, Pivot, Chart and Report sections. You click on items in the Catalog pane and drag them to the outliner to build the content of your pivot, chart or report. For additional information, see "Create a Pivot".
Outliners may be hidden, unhidden, resized, and docked. For more information, see "Understand the Report Outliners".

Understand Toggle Switches
Click on a toggle switch to display hidden outliners or command lines or hide outliners or command lines that you do not want to view. Hiding outliners and command lines increases what is displayed in the Document Section.

Procedure

In this example, we will explore toggle switches.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>The various panes are shown. Document parameters are found at the bottom of the page, the Outliners. You would like to increase your Document Section and will remove the Outliner panes.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
<tr>
<td>2.</td>
<td>The toggle switches are in the upper right hand corner of the Section bar. &lt;br&gt; Click the <strong>Table</strong> button.</td>
</tr>
<tr>
<td>3.</td>
<td>Notice the Table outliner has been removed. &lt;br&gt; Click the <strong>Groups</strong> button.</td>
</tr>
<tr>
<td>4.</td>
<td>Notice the Groups outliner has been removed, increasing Document space. You would like to add the Sort line. &lt;br&gt; Click the <strong>Sort</strong> button.</td>
</tr>
<tr>
<td>5.</td>
<td>The Sort line appears. &lt;br&gt; In this example, we want to explore the Table view of this document. &lt;br&gt; Click the <strong>Table</strong> button in the Sections pane.</td>
</tr>
<tr>
<td>6.</td>
<td>The report Table opens. &lt;br&gt; We would like to add the Filter line to the top of the Document section. &lt;br&gt; Click the <strong>Filters</strong> button.</td>
</tr>
<tr>
<td>7.</td>
<td>Notice the Filter line appears. &lt;br&gt; Click the <strong>Sort</strong> button.</td>
</tr>
<tr>
<td>8.</td>
<td>Notice both the Sort and Filter lines have been added. <strong>End of Procedure.</strong></td>
</tr>
</tbody>
</table>

**Understand Command Lines**

Command lines display below the Section Bar. Command lines offer a visual way to perform query and reporting processes. Drag items to one of the four command lines to retrieve particular data, sort it in a certain order, filter your search to only certain values, or apply a data function. All lines can be hidden, resized, or docked.

**Hide/Unhide a Command Line**
Procedure

In this example, we have the Query section open and want to see the details of the Command Line and need to Unhide the Command Line.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1.   | Notice that on this screen there are toggle switches for Requests, Filters and Sort.  

  **Request** displays the parameters requested from the Main Page.  

  **Filters** display the filters/limits you have set for this report.  

  **Sort** displays any specific sort information.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.</td>
<td>We want to display the Command lines (Request, Filter and Sort) that were applied to this report. Notice there are 15 Request items that we want to display. Click the <strong>Request</strong> option.</td>
</tr>
</tbody>
</table>

![Image of Request Command Line](https://example.com/request.png)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.</td>
<td>Notice the Request Command Line displays specific data items. We wish to display the 16 <strong>Filters</strong> or limits applied to this report. Click the <strong>Filters</strong> option.</td>
</tr>
</tbody>
</table>

![Image of Filters Command Line](https://example.com/filters.png)
### Step 4
Notice the Filter Command line displays.

Click the **Sort** option. Notice there are no additional sorts at present.

### Step 5
All three of the Command Lines now display.
**End of Procedure.**

### Resize and Dock a Command Line

The items in a command line may be numerous and time-consuming to scroll through. Resize the command line to see all the items and work more easily with them.

When you finish working with a floating command line, you can redock it under the Section Bar.

### Procedure

In this example, we would like to increase the size of a specific command line and then redock it.
### Step 1
You wish to increase the size of the Filter command line.

Double-click the **vertical line** along the **left** edge of the Filter command line.

### Step 2
You may use the **cursor** to expand the Filter line by dragging it lower.
## Step 3
Notice the filter command line has now expanded. You are able to more easily visualize the content. The floating box is able to be opened more by using your mouse which turns into a double-arrow (point up and down) to indicate vertical resize.

## Step 4
You wish to redock the **Filter** Command line.

Double-click the **Title bar** of the floating command line.

## Step 5
You have resized the **Filter** line and redocked it.

**End of Procedure.**
Work with Sections

Add a Section

Procedure

If you want to create a chart, pivot or new report, you need to first add that section.

In this example, we will add a new section and add a pivot. For more detailed information about Pivots, see "Work with Pivots".

---

**Step** | **Action**
--- | ---
1. | You want to create a pivot of these results.
   
   Click the **Insert** button.

---

2. | The Insert drop-down menu appears.
   
   Click the **New Pivot** option.
### Step 3

Note the Document pane and Outliner section are available.

The Section pane now displays the **Pivot** button.

To create a pivot, see "Work with Pivots".

### Step 4

**End of Procedure.**

---

## Duplicate & Rename a Section

**Procedure**

We have created a pivot of the Fiscal Year 04-05 Course Expenses as designated by Flex. We have named the pivot: 04-05 Course Expenses (Flex). We would like to duplicate this pivot and then modify it using Fund.

In this example, we will duplicate the original pivot and rename the second pivot, allowing us to study both pivots.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Our pivot is in the Document Section. By selecting the item in the Sections pane we will duplicate the pivot. &lt;br&gt;Click the <strong>04-05 Course Expenses (Flex)</strong>.</td>
</tr>
<tr>
<td>2.</td>
<td>Right-click <strong>04-05 Course Expenses (Flex)</strong>.</td>
</tr>
<tr>
<td>3.</td>
<td>The right click drop-down menu appears. &lt;br&gt;Click the <strong>Duplicate Section</strong> option.</td>
</tr>
<tr>
<td>4.</td>
<td>Notice the item has been duplicated and given the same name with the number 2 at the end.</td>
</tr>
<tr>
<td>5.</td>
<td>We will now rename this pivot. &lt;br&gt;Click <strong>04-05 Course Expenses (Flex)2</strong>.</td>
</tr>
<tr>
<td>6.</td>
<td>Right-click <strong>04-05 Course Expenses (Flex)2</strong>.</td>
</tr>
</tbody>
</table>
### Hide/Unhide the Section Pane

**Procedure**

---

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.</td>
<td>The right click drop-down appears.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Rename Section...</strong> option.</td>
</tr>
<tr>
<td>8.</td>
<td>The Section Label dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>Delete (Flex)2.</td>
</tr>
<tr>
<td></td>
<td>Enter the desired information into the <strong>Label</strong> field. Enter &quot;<em>(Fund)</em>&quot; at the end of the name.</td>
</tr>
<tr>
<td>9.</td>
<td>Notice the name has changed.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>OK</strong> button.</td>
</tr>
<tr>
<td>10.</td>
<td>Notice the two names in the Sections pane.</td>
</tr>
<tr>
<td></td>
<td>You can now drag and drop additional items into the rows and facts outliners.</td>
</tr>
<tr>
<td>11.</td>
<td><strong>End of Procedure.</strong></td>
</tr>
</tbody>
</table>
When not in use, you can hide the Sections pane and view more of the Content pane. In this example, we will hide and unhide the Sections pane.

Step | Action
--- | ---
1. | Click the X (Close) in the Sections pane.
2. | The Section pane is not visible.
   
   After reviewing the data, you want to view the Sections pane again.

   Click the View option.

3. | The View drop-down menu appears.

   Click the Section/Catalog option.
Step | Action
--- | ---
4. | The Sections pane displays.

**End of Procedure.**

**Delete a Section**

You can delete any section. However, do not delete the Query or Results sections. If you delete Query, you will not be able to reprocess the report as it was intended to run. If you delete Results, you will lose all results in the report, pivot, chart, and other sections that use those results.

Procedure

In this example, you will delete a section, in this case the item "Pivot" as displayed in the Sections pane.
Step | Action
---|---
1. | Click **Pivot** in the Sections pane.
2. | Right-click **Pivot**.
3. | The right click drop-down menu appears. Click the **Delete Section...** option.
4. | The Delete Section message appears. Click the **Delete** button.
5. | The pivot has been deleted from the Content and Sections panes. **End of Procedure.**
Work With The Query Section

The Query section has three command lines, Sort, Request, and Filter, and one or more Metatopics. A Metatopic is a list of items (i.e., fields such as Org Code) from one or more tables in the database. The Metatopics vary depending on the report selected. Each Metatopic is made up of items. These items represent categories of information, such as flexfield, PO description, or vendor ID, and are analogous to column fields in a database table.

Generally, the FACT Metatopic contains details about the transactions, such as the PO ID or, in the case of summary reports, details about the balance. The COA Metatopic contains chartfield values and their attributes, such as description and tree level. The third Metatopic contains all other data elements.

The formatting possibilities described in this section are not exhaustive. Once you are comfortable selecting elements and making some formatting changes, explore further by selecting elements and using the various menus and toolbars.

Build the Request Line

Placing items on the Request line instructs the database to return data for those items. The Request lines of BAIRS reports are pre-populated with items.

You can accept the Request line as is or you can add or remove items.

Procedure

In this example, we have run a summary report for one year, without detailing specific months to review.

In this example, you want to add the item Accounting Period (under the FACT Metatopic) to the Request line so that individual months will be displayed in your results.
### Step 1

Note there are three Metatopics and under each Metatopic there are topics or items.

### Step 2

In this example, we will drag and drop **Accounting Period** to the Request line.

Click the **FACT Actual Temp Ledger** item, **Accounting Period**.

### Step 3

Drag and drop **Accounting Period** to the Request line.
Step | Action
--- | ---
4. | Notice **Accounting Period** is now on the Request line. You will now need to re-process this report. Click the **Process** button.

Step | Action
--- | ---
5. | After processing, you return to the results document. You want to review the last column in this most recent query. Scroll to the end of the results. Click the horizontal **Scrollbar**.
Step | Action
--- | ---
6. | Notice the added column details the **Accounting Period** expenses. This column many now be used to further modify results.
7. | **End of Procedure.**

Try to Remove a Critical Item from Request Line

Procedure

In this example, we want to remove the Fund Status Code from the Request line.

![Image](https://example.com/image.png)

Step | Action
--- | ---
1. | Click the **Fund Status Code** option.

*Fund Status Code*
2. The **Remove Query Column** information box appears.

If you remove an item that is used in a computation or format in the Report section, you will receive a Remove Query Column warning.

In general, you do **not** want to remove items used in computations or formats of the pre-built reports.

In this case we do **not** want to remove this item.
Apply a Sort to a Query

This step is optional. Generally, sorting is more meaningful when applied in either the Results, Report or Pivot sections, after the query has processed. If you need to sort at the query stage, this example will show you how.

If the Results section contains a sort, that sort overrides the Query sort.

Procedure

In this example, we will add a Sort to the command line.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>In this example, we want to sort by Org Code. Click and drag <strong>Org</strong> from the Request line to the Sort line.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 2.   | When you look at the **Org** button, the triangle is displayed showing how the item is sorted.  
In this example, this sort is in Ascending order (triangle pointing up) and we would like the Org to be sorted in Descending order.  
Right-click the **Org** button. |
| 3.   | Notice that it is presently sorting in Ascending order as designated by the check mark.  
Click the **Sort Descending** option. |
**Step** | **Action**  
--- | ---  
4. | Notice the **Org** is now sorting in **Descending** order (triangle pointing down). You want to remove the **Org** item from the **Sort** line. Right-click the **Org** button.  

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.</td>
<td>The right click drop-down menu appears. Click the <strong>Remove</strong> option.</td>
</tr>
</tbody>
</table>
Add a Simple Filter to a Query
In a Query, you can accept the filter item(s) as they are set, add new item(s) to the Filter line, or change the filters of the pre-populated items. Whether you add an item, change one, or accept the Filter line as is, a Filter dialog box appears and prompts you to set a filter for that particular item or for the items with variable filters.

For additional information see, "Understand Filter Dialog Box - Pre-Populated Items".

Procedure

You have run a query and have ignored the Fund.

In this example, you will add a filter requesting the Fund 19900.
1. Although you ignored Fund in the initial query, you want to filter the fund.

   Double click the Fund Code item in DIM COA Metatopic column.

2. The Filter dialog box opens.

   For more detailed information, see "Understand Filter Dialog Box - Pre-Populated Items".
3. The cursor is in the Edit field.

Enter the desired information into the field. Enter "19900".

4. Click the Green Check Mark.

5. The value 19900 has been moved from the Edit field to the Values field.

Click the OK button.
Notice the Fund Code item in the Metatopics (DIM COA) has been highlighted and has the = symbol in front of it.

The query needs to be processed with this new filter.

Click the **Process** button.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.</td>
<td>Notice the Fund Code item in the Metatopics (DIM COA) has been highlighted and has the = symbol in front of it. The query needs to be processed with this new filter. Click the <strong>Process</strong> button.</td>
</tr>
</tbody>
</table>

Your new query results display.

The results of your new query are displayed.

**End of Procedure.**

**Remove a Simple Filter from a Query**

When you remove the item from the Filter line and process your query, your data will no longer filter according to that item. For instance, if you remove Fund Code (19900), the query will return all funds that match your authority and your other criteria.

**Procedure**
In this example, we will remove the Fund Code (19900) from the Filter line.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>We previously added the value 19900 to the Filter line. In order to remove it from the line, scroll along the filter line until you see the item (Fund Code2).</td>
</tr>
<tr>
<td>2.</td>
<td>Click the <strong>Fund Code</strong> item on the Filter line.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 3.   | Right-click the **Fund Code**.  
Macintosh and windows may also click on item and press Delete key. |
| 4.   | The right click drop-down menu appears.  
Click the **Remove** option. |
| 5.   | Notice the Fund Code item has been removed from the Filter line. The query needs to be processed with this new filter line. |
| 6.   | **End of Procedure.** |
Work With the Results Section

Once a query is processed, data is returned to the Results section. Data appears in a single table. Items from the Request line make up the column headings. A row appears for each database record.

Data in the Results section is used to create pivots, charts, and tables. As such you can use the Results section, for example to apply local limits, format the numbers, or add a computed item. The changes you make in the Results section will be reflected in any pivots, charts, and/or tables you create from that document.

The formatting possibilities described in this section are not exhaustive. Once you are comfortable selecting elements and making some formatting changes, explore further by selecting elements and using the various menus and toolbars.

Add/Remove Local Filters

After data is returned, you might like to see how it would look if you had filtered it to a particular fund or flexfield. You can do so without having to rerun the query by applying a filter to the results set. This type of filter is called a local filter.

Since other sections, such as reports, are based on data in the Results section, local filters applied to Results will apply to all other sections. You can always remove this filter to return the original data.

Procedure

In this example, we will create a local filter (limit the Fund to 19900 data items) on our results.

Users who do not have the Interactive Report Web Client installed please see, "Understand HTML - Advanced Skills".
### Step 1
Notice that our report shows a number of different Funds. On the Main Page we had ignored the Fund and searched by our Org Code only.

Click the Gray Bar at the top of the Fund column.

### Step 2
Notice that Fund column is highlighted.

The Filter line is available.

If the Filter line were closed, you would need to use the toggle switches in the upper right hand corner of the document.

### Step 3
The Filter box opens.

For more detailed information, see "Work with Filters".

Enter the desired information into the field. Enter "19900".
Step | Action
--- | ---
4. | Click the **Green Check Mark** to move the item from the Edit field to the Values field.

Step | Action
--- | ---
5. | Click the **OK** button.
6. Notice that your Results have been filtered to include only 19900 Funds. The Filter line shows that a local filter has been created.

7. After reviewing our data, we would like to delete the local filter. Click the item (Fund) in the Filter line.

8. Right-click the Fund option.
Step | Action
--- | ---
9. Notice that when you right click on Fund, the filter parameter (19900) displays.
In this example, we want to remove this filter. Click the **Remove** option.

10. Notice the local filter has been removed.
**End of Procedure.**

**Format Numbers**
If you want to change the number formatting form "00" to "$00.00" for example, change the format in the Results section to avoid formatting numbers for each pivot or chart you may create associated with that document.

**To Format a Single Column**
- To select one column, click either the gray bar above the column or the column itself, not the blue headers. The column should appear highlighted.

**To Format Multiple Columns**
- To select adjacent columns, select one column, then press the Shift key and simultaneously click on the last column you want to format. All columns should be highlighted.
- To select non-adjacent columns, select one column, then press the Control key and simultaneously click each column you want to format. All the columns should be highlighted.
Procedure

We have run our report. As we review our information we have decided that we will format our numbers in the Balance column.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Click the <strong>Gray Bar</strong> at the top of the Balance column.</td>
</tr>
<tr>
<td>2.</td>
<td>Notice that the Balance column is highlighted. Right-click the <strong>Gray Bar</strong>.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
<tr>
<td>3.</td>
<td>The right click drop-down menu appears. Click the <strong>Number...</strong> option.</td>
</tr>
<tr>
<td>4.</td>
<td>The Properties - Number dialog box opens. Notice in the Preview pane the number format as it is currently, <strong>displays</strong>. In this example, you would like to eliminate the decimal point. Click the <strong>#,##0</strong> option.</td>
</tr>
<tr>
<td>5.</td>
<td>Notice in the Preview pane, the decimal point has been removed. Click the <strong>OK</strong> button.</td>
</tr>
</tbody>
</table>
Create Grouping Columns

The Grouping Columns feature in the Results section allows you to create a new column by grouping existing columns in the dataset. For example, if you want the value "Q1" to represent data for Accounting Periods 1 through 3, you would create a group.

Grouping columns and computed items differ in a few ways. Use grouping columns for non-numeric data, such as Accounting Period or Fiscal Year. Grouping columns may need to be updated when you re-run your report in a later accounting period. Computed items, if created solely with formulas, do not need to be updated.

For more detailed information on computed items, see "Create Computed Items".

Procedure

In this example, we will run the GL Sum by Account L4 BUDSUM to determine the monthly expenses for the past two months for Fund 19900 and Org 12307. We will create a Grouping Column, and group our expenses into three categories: Salaries, Benefits and Other.
### Step | Action
--- | ---
1. | The **GL Sum by Account L4 BUDSUM** is a Summary report which provides the basic report information. We will then create a group column. Note the parameters we have selected. Press the **Run Report** button.
2. | The "Reports are Ready to View" message appears. Click the **OK** button.
3. | The Select Report to View page appears. Click the **by Org, Fund, Proj, Flex, Pgm** option.
4. | You review your report. You want to do more advanced data work and need to go behind the Main Page. Click the **View** button.
5. | The View drop-down menu appears. Click the **Section/Catalog** option.
6. | The Sections, Catalog and Document panes open. Click the **Results** option.
7. The Results data appears. You need to scroll to the **Account Level4 Node** column.

   Click the horizontal **Scrollbar**.

8. We are interested in the column **Account Level4 Node** because we will group these items into Salaries, Benefits and Other.

   This new grouping will add another column to our Results section.
9. You want to highlight **Account Level4 Node** Column.
Select the **Gray Bar** on top of the Account Level4 Node column.

10. Notice that the entire column is highlighted.
Right-click the **Account Level4 Node** Column for options.

11. The right-click drop-down appears.
Click the **Add Grouping Column**... option.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
The column selected appears in the dialog box title bar as well as in the Column Name field.  
The items in the Available Values box, in the bottom right, are all the values from the column selected. Since we selected the Account Level4 Node, these are the values available to be grouped. |
| 13.  | **In this example, we want to rename our column.**  
Highlight the Column Name: **Group of Account Level4 Node**. |
| 14.  | **We want to delete the default name and rename the column.**  
Press [Delete]. |
| 15.  | **We would like our column to be meaningful.**  
Do not use any spaces, use underscore instead.  
Enter the desired information into the **Column Name** field.  
Enter "Cost_Category". |
16. Notice that we have changed the name of our column.
   We will enter the name of our first group.
   Press the **New Group** button.

17. The New Group box opens.
   Enter the desired information into the **Name** field. Enter "Salaries".
18. Click the **OK** button.

19. In the **Available Values** box, select the values you want in this group.

   To select **one value**, click on it.

   To select **adjacent values**, click on one and then simultaneously press the Shift key and click on the last value.

   To select **non-adjacent values**, click on one value and then simultaneously press the Ctrl key and click other values until all are selected.

20. In this example, you want to select two adjacent values, thus grouping the salary BFS Expense Account Level4 Nodes.

   Click the **50XXX** option.

21. Press the [Shift] key and click the **51XXX** option.
Step | Action
--- | ---
22. | Notice both **50XXX** and **51XXX** are highlighted. You want to move the highlighted values to the Items in the Group box. Click the **Left Pointing Arrows**.

23. | Notice that **50XXX** and **51XXX** have been moved from the Available Values box to the Items in Group box.

24. | You now want to create a new grouping. Press the **New Group** button.
Step | Action
---|---
25. | The New Group dialog box opens. Enter the desired information into the **Name** field. Enter "**Benefits**".

26. | Click the **OK** button.

27. | You want to group the Benefits BFS Account Level4 Node. Click the **52XXX** option.

28. | Press the **[Shift]** key and click **53XXX**.
Step | Action
---|---
29. | Notice both items are highlighted. Click the **Left Pointing Arrows**.

30. | Notice that Benefits now has two items in its group.

31. | Press the **New Group** button.
### Step 32
The New Group dialog box opens. Enter the desired information into the **Name** field. Enter "Other".

### Step 33
Click the **OK** button.

### Step 34
The remainder of the Available Values need to be grouped under Other. Click **550XX**.

### Step 35
After highlighting the first item, press the **[Shift]** key and click the vertical **Scrollbar** on the Available Values box.
36. Press the [Shift] key and click the last item in the list, value 58100.

37. With all the items highlighted in the Available Values box, you want to move them to the Items in Group box.

   Click the Left Pointing Arrows.

38. Notice there are no items in the Available Values box. This is very important to make sure that you captured 100% of the items.

   Click the OK button.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>39.</td>
<td>You want to see the new column you have created, the Cost Category column. Click the horizontal <strong>Scrollbar</strong>.</td>
</tr>
<tr>
<td>40.</td>
<td>Notice the new column. This column can now be used to create a pivot or chart or to create a computed item. For more details, see &quot;Create a Pivot&quot;, &quot;Create a Chart&quot;, and &quot;Create Computed Items&quot;.</td>
</tr>
<tr>
<td>41.</td>
<td><strong>End of Procedure.</strong></td>
</tr>
</tbody>
</table>

**Create Computed Items**

A computed item is a "virtual" column as opposed to a column physically stored in the database. When you add a computed item, you are creating an equation using existing items and adding a new column to the results set. This computed item is also added to the Catalog panes of reports, tables, pivots, and charts, for you to use in those sections as well.

You can add computed items in other sections, but they will be available only in that particular section. That is, if you modify a pivot, only that particular pivot will have the modification. Only computed items added to the Results section are available for your use in all other sections.

You can use computed items, for example, to add Tempbudg and Actuals to see your "working" or "cash" balance. The following instructions are to introduce you to computed items and are not intended as a complete description of this powerful tool. For more information, click Help on the Hyperion menu bar and in the Index and select the specific calculated items you are interested in mastering.
Procedure

In this example, we are going to add a computed item. We will take the data from the Results and have the computer calculate our Working Balance which is the Temporary Budget plus our Actuals (expenses).

**Step** | **Action**
--- | ---
1. | We have run our report and gone behind the Main Page. Notice we are in the Results format as shown by the depressed Results button in the left Sections pane.

We are going to create an equation using existing elements on the Results table. The equation (Working Balance) will be created as its own column on the Results table.

Click the Results button at the top of the page.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.</td>
<td>The Results drop-down menu appears. Click the <strong>Add Computed Item...</strong> option.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 3.   | The **Name** field is the name of the computed item you are adding and will appear on the column head and in the Catalog pane. It needs to be something meaningful to you. At present, the Name is "Computed".  

The **Functions** button allows you to utilize internal functions such as math (for example, return the absolute value), numeric (return the largest value in a column of numbers), and statistical (such as return the median of a column of numbers) in your equation.  

The **Reference** button opens a dialog box with all the items in your results set. These items are available for you to manipulate mathematically in the new column.  

The **Operator** buttons apply mathematical functions or logical operators to your equation. |
4. You want to name your new column, Working_Balances. Click the **Name** field.

5. Highlight the default name, **Computed**.

6. The default name, "Computed" is highlighted. Press [Delete].

7. The Name field is now empty. Do not use spaces, use underscores, instead. Enter the desired information into the **Name** field. Enter "Working_Balance".
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.</td>
<td>Notice the new name of this computed item, &quot;Working_Balance&quot;. Rather than create your own equation, we will allow the computer to display possible items. Click the <strong>Reference</strong>... button</td>
</tr>
<tr>
<td>9.</td>
<td>The <strong>Reference</strong> dialog box appears. The left box says, &quot;Request&quot; and the right box had &quot;Items&quot;. Notice the Items in the Item box. These items are items in the results set, the ones you will use to build your equation.</td>
</tr>
</tbody>
</table>
10. From the list of available items (in the right box), click the Tempbudg option.

11. Notice Tempbudg item is highlighted.

Click the OK button.
### Step 12

**Tempbudg** now appears in the Definition Field. It is the first part of your equation.

You want to click the Operator button to insert the mathematical or logical operator that is associated with this equation.

In this example, you will select the plus sign (+).

Click the + button.

### Step 13

Notice the + sign has been added to the Definition field. You want to finish your equation, by adding "Actuals".

Click the Reference... button.
Step | Action
--- | ---
14. | The available items in the right Item box appear.
   | Click the **Actuals** option.
15. | Notice that **Actuals** has been highlighted.
   | Click the **OK** button.

16. | Review your equation, in the Definition field.
   | If you add your Tempbudg and your Actuals, you will have your Working Balance.
   | Click the **OK** button.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 17.  | We want to see the column that was added that contains our computed item(s).  
      | Click the horizontal **Scrollbar**. |
| 18.  | A new column, labeled "Working_Balance" appears as the last column in Results.  
      | If you now inserted a new pivot or opened one of the pre-built reports, you would find an item in the Catalog pane, labeled "Working_Balance".  
      | For more information about how you might use this computed item, see "Create a Complex Pivot - Use Grouped and Computed Items". |
| 19.  | **End of Procedure.** |

**Work with the Report Section**

The Report section covers how to modify and format the pre-built reports that come with all BAIRS reports. To be able to modify BAIRS reports, you first need to understand the elements that make up these reports.

**The Report Outliner**

The structure of the report, which determines what information is displayed as well as the subtotaled and sorting options, is built by the outliner. The Report outliner has three panels, Report Groups, Table Dimensions, and Table Facts. The Report Group panel is further subdivided into Groups 1, 2, 3, etc. Generally BAIRS reports are built with Groups 1 and 2.

*Items in Report Group 1 Generally:*

- Correspond to the first item in the sort order
- Make up the main sort or "focus"
- Have a grand total
- Are made up of chartstring information

*Items in Report Group 2 Generally:*

- Create subgroups within Group 1
- Provide the full grouping for the table
- Are made up of chartstring information
Items in the Table Dimensions:

- Are non-quantifiable items, such as Transaction Type or Account Code
- Make up the text columns on the left side of the Report
- Summarize the facts items

Items in the Table Facts:

- Are quantifiable items, such as Tempbudg and Actuals Amounts
- Are values used in calculations, including subtotals and grand totals
- Appear in columns to the right of the Table Dimension column(s)

The modifications explored here are not exhaustive. Once you are comfortable selecting elements and making some modifications, explore further by selecting elements and using the Format menu, the Report menu, the Formatting toolbar, and right-click for PC users or alt/option-click for MAC users speed menu options.

Understand the Report Outliner & Add/Remove

Procedure

In this example, we will explore the Report Outliner panels and add/remove them.
Step 1. Our report is sorted by Org, Fund, Proj, Flex, Prg as seen under the report title.

Notice that Org is in Report Group 1 in the outliner, and Fund, Proj, Flex and Program are in Group 2.

Thus, this report groups first by Org and then within org groups, fund, proj, flex and program. This allows for a table to be displayed and subtotaled for each unique combination of fund, flex, project and program within each org. It also allows the report to sort and grand total by org.
Step | Action
--- | ---
2. | Notice that **Account Level4 Node** and **Account Level 4 Description** appear in the **Table Dimensions** outliner and along the left side of the report body.

The account codes summarize the **Facts** items, Tempbudg, Actuals, Encumbrances, Pre-Encumbrances, and Balance. These facts are added to make up the subtotals and grand totals.

---

Step | Action
--- | ---
3. | We want to close the Sort line.

Click the **Sort** button (toggle switch) at the top right of the report.
4. Notice the Sort line is no longer visible.

You want to close the Group panel in the outliner and the bottom of the report.

Click the Groups button (toggle switch) at the top right of the report.
### Step | Action
--- | ---
5. | Notice the Groups outliner is not visible.

We want to **close** the Table outliner at the bottom of the report.

Click the **Table** button (toggle switch) at the top of the report.

6. | Time passes.

You may open your report outliner.

Click the **Table** button.

7. | Notice that the Table outliners are available. You would also like to add the Group outliner.

Click the **Groups** button.

8. | If you would like to open the Sort line, click the **Sort** button.

9. | Notice that the Report Outliners are present.

**End of Procedure.**
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td></td>
</tr>
<tr>
<td>3.</td>
<td></td>
</tr>
<tr>
<td>4.</td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td></td>
</tr>
<tr>
<td>6.</td>
<td></td>
</tr>
<tr>
<td>7.</td>
<td></td>
</tr>
<tr>
<td>8.</td>
<td></td>
</tr>
</tbody>
</table>